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The purpose of this document

The purpose of this document

This document contains instructions on how to set up and use the enhancements implemented in the
Aloha® Solution 2025 enhancement release. In some instances, we combine features together to
better explain the new enhancements. When applicable, we include a scenario, how to configure the
feature in the Back-of-House (BOH), how to use the feature in the Front-of-House (FOH), and
references to other materials to fully implement the feature. This document is not intended to fully
explain a particular function or other options available or surrounding the function. This document
does not guarantee the options are in the same location, nor that the functionality remains the same
due to enhancements implemented in future versions of the affected products.

What you need to know before installing Aloha Solution 2025

You need to know the following before installing Aloha Solution 2025.

PCI Software Security Framework (SSF)

Aloha Solution 2025 is validated against PCI Software Security Framework (SSF) standards. PCI SSF
is a collection of standards and programs for the secure design and development of payment
software. Security of payment software is a crucial part of the payment transaction flow and is
essential to facilitate reliable and accurate payment transactions.

.El Reference

Refer to Aloha Solution Data Security Handbook Implementation Guide - HKS1653 for more
information.
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Setting the LAN Manager authentication level

The LAN Manager authentication level for Microsoft® Windows® 10 and 11 determines the response
protocol used for network logons. For ATO to work properly, you must set the level to ‘Send LM &
NTLM — use NTLMv2 session security if negotiated.” This setting is for BOH only and cannot be
performed during the RAL or ATO installation. Newer images are equipped with this requirement;
however, you need to check this on your local computer and set the proper level. You must use an
administrator account fo set this.

2

File Action View Help

o | XEE Bm Network security: LAN Manager authentication level Prop... 7 X
5y Security Settings I Policy B SE(UHI}'SE; Local Securty Setting  Explain

3 Account Policies
w 4 Local Policies
4 Audit Policy
4 User Rights Assignment
4 Security Options z
| Windows Defender Firewall with Adve] 21| Network access: Let Everyone permissions apply to anonym... Disabled Send LM & NTLM - use NTLMv2 session security  negotiated v
2z Network access: Named Pipes that can be accessed anonym...

«) Network access: Allow anonymous SID/Name translation Disabled :i. Metwork security: LAN Manager authentication level
i Network access: Do not allow anonymous enumeration of S.. Enabled

.1 Network access: Do not allow anonymous enumeration of S... Disabled
.1 Network access: Do not allow storage of passwords and cre... Disabled

Network List Manager Policies Modying this setting may affect compatibility with clients. services,

| Public Key Policies i Network access: Remotely accessible registry paths System\Cu 1 and applications
Software Restriction Policies i) Network access: Remotely accessible registry paths and sub... System\Cu For more information, see Network secunty: LAN Manager
Application Control Policies _«) Network access: Restrict anonymous access to Named Pipes... Enabled authentication level. (A823655)
g IP Security Policies on Local Compute | Network access: Restrict clients allowed to make remote call... Not Defined
Advanced Audit Policy Configuration|| L« Network access: Shares that can be accessed anonymously  Not Defined

«) Network access: Sharing and security model for local accou... Classic - lo
s Network security: Allow Local System to use computer ident... Mot Defined
« Network security: Allow LocalSystem NULL session fallback Mot Defined
2z Network security: Allow PKU2U authentication requests to t... Not Defined
.1 Network security: Configure encryption types allowed for Ke... Mot Defined
2x) Network security: Do not store LAN Manager hash value on ... Enabled

iz, Network security: Force logoff when logon hours expire Disabled
& Network security: LAN Manager authentication level Send NTLMy
_: Network security: LDAP client signing requirements Negotiate s

| Network security: Minimum session security for NTLM SSP ...  Require 128
21| Network security: Minimurn session security for NTLM SSP ... Require 128

Natwnek caruritie Rectrict NTI e Add ramnte cenver sveenti Aot Nefinad Cancel Apply

Figure T LAN Manager authentication level
To set the LAN Manager authentication level:

Using the Windows search bar, search for and open the Local Security Policy app.
In the ‘Security Settings’ tree, expand Local Policy.
Select Security Options.

b~

Under the Policy list, locate Network security: LAN Manager authentication level. The
Properties dialog box appears with the Local Security Setting tab open.

5. Select Send LM & NTLM — use NTLMv2 session security if negotiated from the drop-down
list.

Click OK.
7. Exit the Local Security Policy app.
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Integrating with AlohaCP

AlohaCP, previously known as Aloha Payment Service (APS), now integrates seamlessly with the
Aloha POS system. Prior to this enhancement, when you set up Aloha to process payments through
the NCR Voyix Payment Gateway (NPG), also known as Connected Payments, you had to:

e Run the installation of Aloha POS.

e Download AlohaConnectedPaymentsSetup.exe and separately install the NPG solution, which

installs both APS and OpenEPS, is manifest-based, and installs a service on the Back-of-House
(BOH).

Effective in Aloha POS v19.9+, when you install Aloha POS, either interactively or silently, the
installer automatically installs/upgrades AlohaCP for you.

Reference
Refer to Alohas POS APS to AlohaCP Migration QRG - HKS1545 for more information.
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RAL (Remote Application Loader)

The PCI Least Privilege user requirement indicates that users of a payment application, such as the
Aloha POS system, cannot carry more system privileges than strictly needed. Because of this require-
ment, the terminal user accounts no longer get administrative rights to perform registrations, installa-
tions, and other actions. To enable POS features and third-party applications to install via RAL, we
provide a mechanism to support Chocolatey (Choco) package installation on the FOH terminals.
Choco package files contain the instructions that RAL uses to install integrated and third-party applica-
tions on the FOH terminal, as well as perform actions necessary for the applications to function. Each
application that relies on RAL for its FOH terminal installation must provide the terminal install Choco
package with its own BOH installation. RAL now supports the Choco package installation for terminal
configuration, as well as /S related terminal configuration, on BOH devices.

.El Reference

Refer to RAL v20.0 User Guide - HKS484 and Creating an Aloha Compatible Chocolatey Package -
HKS1657 for detailed information.
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Aloha POS

The following POS enhancements are included in the Aloha Solution 2025 Enhancement Release
Guide:

Supporting InStore API for notification and ordering

Tracking

Version Products Audience

Number

Aloha Quick Service, Aloha Table Service | Configuration Technician
End User

Aloha Transaction Gateway (ATG) offers a solution for consuming the Aloha Point-of-Sale (POS)
events occurring on the terminals. Previously, this function was available through the Terminal Events
API. Now with the integration of Kafka into ATG, consumers can receive events by connecting to the
Kafka Broker, while also leveraging the additional capabilities provided by Kakfa.

Reference

Please consult with your NCR Voyix representative for onboarding a customer and obtaining the
appropriate documentation.

Adding message for incorrectly formatted QR code using a non-integrated scale

Version Tracking Products Audience
Number
POS v19.11.2 | ALOHAP-33871 | Aloha Quick Service, Aloha Table Configuration Technician
Service End User

In POS v19.9, we added support to allow the cashier to scan a QR (quick response) code generated
from a scale that is not attached to an Aloha POS terminal. This solution helps environments that
weigh items to purchase on a separate scale that prints a QR code, which you then scan at the Aloha
POS system. The single QR code can contain more than one weighted and non-weighted item, which
allows you to scan and enter multiple items all at once at the Aloha POS system. Unlike the integrated
scale solution where you scan items at an Aloha POS terminal from any point of the ordering process,
with this solution, you must access the ‘Multiple ltem Scanning’ screen prior to scanning the QR code
to ring up the item.

.:E:l Reference

Please refer to Scales Feature Focus Guide - HKS1480 for more information on configuring a
non-integrated scale.
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The QR code format consists of multiple components, separated by a semi-colon, and each
component has a designated number of digits. The format is complex and can lead to errors during
configuration. An incorrectly formatted code will stop the entry of the item at the Aloha POS terminal,
without a warning.

Effective in Aloha POS v19.11, the message, “Configured item scanning format is invalid” now
appears when the cashier attempts to scan an incorrectly formatted QR code. There is no
configuration required for this enhancement.

Supporting digital receipts

Tracking

Version Products Audience

Number

POS v19.11.1 | ALOHAP-38371 | Aloha Quick Service, Aloha Table Service | Configuration Technician
End User

A digital receipt, also known as electronic receipt, is proof of purchase issued through a digital
method, such as email or text message, instead of the paper receipt handed to the consumer. Many
restaurants in various countries have adopted this ‘green’ solution to reduce paper waste, provide a
secure and safe transfer of legal documents, and allow the consumer to easily access receipts from a
mobile device. With receipts being digital, you can also insert them into most tax-preparing software
programs.

The Aloha solution uses Aloha Transactional Gateway (ATG) and the Digital Receipt service on the
BSL platform to create a digital version of the receipt and send it as an email/text message to the
consumer. You can adjust your operations to exclusively use digital receipts without a physical
printer, such as a tablet environment, or print the receipt and optionally send the receipt digitally. In
both scenarios, if you forget to send the digital receipt during the initial operational flow, you can
recall the closed check and send it.

.:E:l Reference

Refer to the Digital Receipts Feature Focus Guide - HKS1784 for more information about digital
receipts.
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Disabling configured rounding for payable amount less than .05

Tracki
Version racking Products Audience

Number
POS v19.11.2 | ALOHAP-40163 Aloha Quick Service, Aloha Table Configuration Technician
CFC v21.17 Service End User

The country of Belgium now requires businesses to round cash payments to the nearest five cents in
an effort to reduce the use and circulation of one and two-cent coins, which are expensive to produce
and not cost effective. The fiscal requirement changes how the coinage of a check total under five
cents are handled.

The Aloha POS system already supports rounding for a cash-only transaction when you configure a
cash tender to round in the Tenders function. The system rounds the check total of $20.23 to $20.25,
when paid with cash.

With the new fiscal requirement, you should not round when you pay cash for a check total less than
five cents, such as a transaction for $0.03. Although this may seem rare, this happens more often
when a non-cash payment or promotion is applied to the check, and then you pay with cash. For
example, when a $20.00 meal voucher is applied to a $20.04 check total, and you then pay cash,
the system does not round the remaining four cents.

Effective in POS v19.11, you can now use the store-level ‘Disable configured rounding for payable
amount less than .05’ option to override all tender-level rounding and not round cash payments for a
check total under five cents.

To disable configured rounding for payable amount less than .05:

1. Select Maintenance > Menu > Business > Store.
2. Select the Store Settings tab.

N C R v.".YI X © 2025 NCR Voyix. All rights reserved. NCR Voyix — Confidential
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3. Select the Financials group at the bottom of the screen.

19002 Houston Lab Houston Lab I

Location Information Licensing Custom Store Settings Aloha Configuration Center

Exclude voided items from gross sales
Indude promos discounts in gross sales
Indude comps in net sales

Indude promo discounts in net sales

8 Exclude open sales from BOH reports
lﬁd.demo&ﬁersonFOHProductereport

Exclude zero priced modifiers on FOH Product Mix report
Exclude 100% comp checks from guest and check counts

NORNOO0O0OMNEA

Display FOH labor hours format ‘8&'"::;
Print both minute and decimal formats on tmedock chits |

Report non-cash tenders by terminal revenue center

Tip breakdown prints on dock out chit |

Clock out chit footer message None v
Default minimum dedared tip percentage 8.00

A&

Do not round balance due before tender applied M
 Disable configured rounding for payable amount less than .05 & ]
Generate checkout balance file O

Checkout buckets

Breakfast
| Lunch

Order Entry Labor Finandals Check Printing Chit Printing Report Printing User Interface Security System Credit Card Gift Card/Certifica >

Figure 2 Store Settings - Financials Group

4. Under the ‘Reports’ group bar, select Disable configured rounding for payable amount less
than .05.

Disable configured rounding for payable amount less than .05 — Does not round a check
total that is less than five cents, when the remainder of the check after applying non-cash tenders
is paid with cash. For example, when a $20.00 meal voucher is applied to a $20.04 check total,
and you then pay cash, the system does not round the remaining four cents. This option overrides
any five-cent rounding configured for a tender in the Tenders function. Documented Version:
v19.11.

5. Click Save and exit the Store function.
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Supporting redemption vouchers with QR code

Tracking

Version Products Audience

Number

POS v19.11.2 | ALOHAP-41048 Aloha Quick Service, Aloha Table Configuration Technician
ALOHAP-41049 Service End User

ALOHAP-41216
ALOHAP-41131
ALOHAP-41336

Restaurants sell a wide variety of items for purchase through the Point-of-Sale (POS) system. Some of
these items might not be distributed at the point of purchase (POP), such as a quick service counter,
checkout stand, or any other place from which the consumer places the order. Instead, the consumer
is directed to redeem their prepaid item at another area within the restaurant.

The Aloha® solution offers a way to print a custom response (QR) code on a separate chit called a
redemption voucher. The consumer then scans the QR code elsewhere to redeem the item.

Although the Aloha POS system can already print a QR code, this feature does not require any printer
configuration and automatically prints the QR code provided by the API service on the redemption
voucher.

The system automatically prints a redemption voucher to the local printer assigned to the terminal for
items designated as eligible for a redemption voucher by their inclusion in a user-defined category. If
the item is not included in the category, a redemption voucher does not print.

Using the technology of QR codes, you can use this feature in many hospitality venues.

e A restaurant that utilizes a third-party drink dispenser where consumers must scan a QR code at
the machine to dispense their beverage. Use this solution to restrict refills of all or certain drinks,
such as sugary beverages.

e A restaurant that includes an entertainment area that contains QR code-supported gaming
devices.

e An entertainment venue that contains QR code-supported vending machines, for such things as
t-shirts, bottled drinks, and more.

.:E:l Reference
Refer to Supporting Redemption Vouchers with QR Code QRG - HKS1777 for information.
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Including/excluding comps and promos when calculating guest count

Tracking

Version Products Audience

Number

POS v19.11.2 | ALOHAP-42013 Aloha Quick Service, Aloha Table Service | Configuration Technician
CFC v21.19 End User

Many restaurants use the number of items sold from a category, typically entrees, to calculate the
guest count. Each time you order the item, the guest count increases by the default weight of one.
When the entree is fully discounted by a promotion or a comp, the item is reduced to a $0.00
amount and is no longer respected in the calculation.

Effective in Aloha POS v19.11, you can now use a custom FOH report to include or exclude selected
comps and promotions when calculating the guest count. This gives you maximum control on how
you want an ‘entree-based’ guest count to report. For example, you may want to have a report where
the guest count includes entrees and another report that excludes fully discounted shift meals earned
by the employee.

® Tip
This feature only applies to an entree-based guest count configuration. It is not supported with any
other guest count calculation method.

To configure entrees to be counted as guest counts:

Select Maintenance > Business > Store.

Select the Store Settings tab.

Select the Order Entry group from the bottom of the screen.

Under the ‘Guest Count’ group bar, select Use entrees for guest counts.

Select the category from the ‘Entree Category’ drop-down list.

Sl e ol

Click Save and exit the Store function.
To configure a FOH custom report for guest counts:

Select Maintenance > Business > Custom FOH Reports.
Click New.
Type a name for the report, such as ‘GC with Promos’

Select Allow report to be run by multiple employees at a time.

O M 0=

Select a time increment from the ‘Report format’ drop-down list, such as ‘Sort data in 60 minute
increments.’

Select the Design tab.
Under the ‘Design’ group bar, click Add. A new line of the report appears.

N C R v.".YI X © 2025 NCR Voyix. All rights reserved. NCR Voyix — Confidential
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8. Click the ellipse (...) to display the Report Line Builder dialog box. Using the help text example
and report line as a guide, build the specific line of the report.

Report Line Builder

Categories Elements - Comps _Promos_
Value A | [Total count of all guests ) (O™ Name Owner O Number / Name  Owner
:uoarﬂr:amg s Ll - O 1/8.0.G. 1 Chipo... ~ O 1/$0ffDe...|1 Chipot.. A
Comps O 3|Mngr Comp |1 Chipo. O 2|{2for-1 |1 Chipot...
Delivery [m] 5| Fiyer Comp | 1 Chipo. O 3/%OffD... |1 Chipot..
Employees ]
Entree Count O 7|Bev Coupon | 1 Chipo. O 4|Burrito ... |1 Chipot
Gift Certificates O 8/PRComps |1 Chipo. O 5| PartySe...| 1 Chipot
Gratuities 9/EmpMeals 1 Chipo... O 10 | Vid-Quik... | 1 Chipot
Guest Checks

i [m] 15| Coin Comp | 1 Chipo. [m] 11|idBOG... |1 Chipot...
Items O 30|Vid-Comp% | 1 Chipo. O 12{Vido Co... |1 Chipot...
Items Count O 31|Meal /Bev |1 Chipo ] 13 VidCoupon | 1 Chipot
Order Mode Charges - =
|Petty Cash Accounts v E 32|VidCompO... |1 Chipo... , E 14| VidNewP... | 1 Chipot...

Help text: @ Inclusive " Exclusive

Count of guests for the selected promos and comps, either indusive (any promo/comp selected) or exdusive (any promo/comp except those

selected), per selected Display Option Report format.

Example:

Items Count <Right> <Val(7: #FilteredGuestsindusive 1,2|5,7)>

OK
Report line EmployeeGuests = <Val(7: #FilteredGuestsInclusived[) > e

Figure 3 Print Designer Guest Counts Variable

9. Select Guest Counts from the ‘Categories’ list. The variables for ‘Guest Counts’ populate in the
‘Elements’ list and the ‘Comps’ and ‘Promos’ selection lists become available.

10. Select Guest filtered Inclusive and Exclusive from the ‘Elements’ list.
11. Select one or more comps or promotions from their respective selection boxes.
a. To include all comps or promotions, select the check box above either list appearing in the
selection box.

b. To include specific comps or promotions, select Inclusive and then each comp or promotion
to include in the report from the respective list.

c. To exclude specific comps or promotions, select Exclusive and then each comp or
promotion to exclude from the report from the respective list.
12. Click Insert.
13. Click OK.

14. Add any other design elements to customize the report, such as inserting free text, blank lines,
or a line with a single character.

15. Click Save.
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16. Repeat this procedure to create another custom report with a specific guest count calculation.

17. Exit the Custom FOH Reports function.

Reference
Refer to Custom FOH Reports Feature Focus Guide - HKS320.

© 2025 NCR Voyix. All rights reserved. NCR Voyix — Confidential
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Aloha Kitchen

The following Aloha Kitchen enhancements are included in the Aloha Solution 2025 Enhancement
Release Guide:

Note

Aloha Kitchen is an add-on to Aloha Solutions and is not included as part of the Aloha Essentials
core offering.

Printing order summary chit by priority

Tracking

Version Products Audience
Number

AK v19.13.8 | AK-3794 Aloha Kitchen Configuration Technician
AK-3913 End User

Aloha Kitchen can print an order summary chit at the Aloha POS terminal upon bump that includes
the items prepared at the station for the order. Some kitchens have an ordering flow where each
production station attaches the printed summary chit to the bag and passes it to the next station in the
line, regardless of the components required for the order. The expediter then undergoes the tedious
task of collecting the summary chits from each station to triage and deliver the final product to the
consumer.

Effective in Aloha Kitchen v19.13.8, you can alleviate this type of ordering flow by outlining which
production stations print the summary chit based on the order of priority. The required station
identified with the highest priority (lowest number) prints the summary chit and the summary chit does
not print at the other stations. This eliminates the passing of the summary chit to non-essential stations
and the expediter triages the correct items for order accuracy.

SCENARIO: The kitchen has Grill, Fry, Cold, and Drink production stations. Grill has a priority of 1,
Fry has a priority of 2, Cold has a priority of 3, and Drinks does not have a priority. When an order of
Hamburger, French Fries, Salad, and Coke is sent to the kitchen. the summary chit prints at the Grill
station upon bump, the highest priority. If the order does not include a Hamburger, the summary chit
prints at the Fry station upon bump, the next higher priority.

N C R V.".YI X © 2025 NCR Voyix. All rights reserved. NCR Voyix — Confidential
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To configure printing the order summary chit by priority:

1. Select AK from the product panel.

2. Select Maintenance > Hardware > Kitchen Station.

Kitchen Station

I 1 EXPO Coffee Bean Primary I

Station Limit To Courses Additional Start Stations

Owner 1 Coffee Bean
Number 1
Name |exp0

V Type :E.\'Do N
Ba&a.p station :None ¥
Staff level change backup station . None v
Hidden i ' \ 0O
Master bump O
Allow toggling Y]

i to All stations
[ Bag chit prio 1 J

Combine independent modifiers with parent item
Orde

Auto-start production order view cell

Hide unfinalized orders

Add-on merge method ‘Use Kitchen Settings merge method ~
7 Bump fully prepared orders I
 Allow bump if not finalized

Can only bump tendered orders

Can only bump dosed orders

Exdusion cateqory | None
F Use this expo to e;cpedhe orders .

p Q v

O0OE&

O O0o®0d

Figure 4 Kitchen Station Function
3. Under the ‘Settings’ group bar, type the priority number in ‘Bag chit priority.’

Bag chit priority — Specifies the priority number, with the lowest number being the highest pri-
ority, for a production station to print the summary chit for an order, upon bump. If the station
with the highest priority is not required for the order, the station with the next higher number is
used. When more than one item is routed to the station, only the first bumped item prints. The
system does not recognize stations with the same priority number. If you want a station to never
print the summary chit, clear ‘Bag chit priority.” Use this option for an ordering flow that uses the
summary chit as a bag chit and each production station attaches the chit to a bag for the expediter
to triage for the final product. Documented Version: v19.13.8.

4. Click Save.
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5. Repeat this procedure for another kitchen station.

6. Exit the Kitchen Station function.

Respecting multiple printers in x of y printing sequence on the kitchen chit

Version Tracking Products Audience
Number
AKv19.13.8 | AK-3834 Aloha Kitchen Configuration
CFC v21.18 Technician
End User

Aloha Kitchen currently supports an ‘x of y’ printing sequence for multiple chits and labels for an
order, per printer. When you have another printer in the kitchen, each uses a separate ‘x of y’
printing sequence. The first chit and label prints ‘1 of 2" and the second chit and label prints ‘2 of 2.
For example, the Sandwich printer and Sides printer each print two chits and the ‘x of y' printing
sequence is the same for each printer.

Sandwich printer:

1of 2
2 of 2

Sides printer:

1of 2
2 of 2

Effective in Aloha Kitchen v19.13, you can use the Print Designer tool to configure the ‘x of y’ printing
sequence to respect multiple printers involved in an order. All affected printers utilize a unique
counter, giving the visual appearance the chits are inclusive of the same order. This allows the
expediter to ensure all items are correctly bagged with the same order, and increases order accuracy.
Using the same example, the Sandwich printer and Sides printer are inclusive in the same ‘x of y’
sequence.

Sandwich printer:

1of 4
2 of 4

Sides printer:

N C R v.".YI X © 2025 NCR Voyix. All rights reserved. NCR Voyix — Confidential
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3of4
4 of 4

® Tip

" To properly use this feature and allow Aloha Kitchen to identify the total number of chits (the y
element), you should not use the ‘One behind’ and ‘Immediate’ routing methods defined in
Maintenance > Kitchen Settings > Kitchen tab. Furthermore, the ‘x of y’ printing sequence does not
respect an item added after the it is added after the order is sent to the kitchen

Reference

Refer to the Print Designer Feature Focus Guide - HKS375 for more information on configuring a
kitchen chit layout.

To configure x of y printing sequence across all printers to which the kitchen chit prints:

1. Select Maintenance > Hardware > Print Designer Configuration > Print Designer.

2. Select a production chit or order taker layout in use from the drop-down list.

N C R v.".YI X © 2025 NCR Voyix. All rights reserved. NCR Voyix — Confidential
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3. Select the Design tab.

Print Designer

| 1 Production chit Coffee Bean Primary |

Layout Design
Element Add =
[ p Label Print Sequence ]
Remove
Move up
Move down

Print style settings

Line attribute overrides

Label Print Sequence settings
( Label print text Label print is {0} of {1}

Figure 5 Label Print Sequence Element

4. Under the ‘Design’ group bar, click the Add drop-down arrow, select Label Print Sequence

from the list that appears, and click OK.

Label Print Sequence — Prints the ‘x of y’ chit or label sequence on the kitchen chit, with
respect to all printers involved in the order. For example, if you have four chits printing across
two printers in use, the ‘x of y’ sequence includes both printers in the counter, ‘1 of 4’ to ‘4 of 4.
Documented Version: v19.11. Related Options: This option enables the ‘Label Print Sequence
settings’ group bar and ‘Label print text’ option.

Under the ‘Label Print Sequence settings’ group bar, type the text to print on the kitchen chit in
‘Label print text.’

Label print text — Specifies the text to print for an ‘x of y' printing sequence on the kitchen chit.
The default is ‘Label print is {0} of {1}," enclosed in braces, where {0} is the specific print number
and {1} is the total number of prints. You can modify the free text to further customize the text that
prints on the chit. Documented Version: v19.11. Related Options: You must add the ‘Label
Print Sequence’ element to a ‘Production chit’ or “Order taker chit’ layout to enable this option.

N c R v.".YI X © 2025 NCR Voyix. All rights reserved. NCR Voyix — Confidential
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6. Click Move up or Move down to change the top-down order in which elements appear on the
layout.

Click Save.
Repeat this procedure for another kitchen chit or order taker layout.

Exit the Print Designer function.
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Aloha Takeout

The following Aloha Takeout enhancement is included in the Aloha Solution 2025 Enhancement
Release Guide:

Displaying app orders from ATO on the AccuView display board

Rel Tracki
€ e?sed racking Products Audience
Version Number
ATO v20.1.3 ATO-5505 Aloha Takeout, Configuration Technician,
ATG v21.0.1 End User
CFC v21.19

NCR Voyix integrates with AccuView® to provide a scalable display board solution at the drive-thru
lane. To support the increase of app and web orders flowing through the drive-thru lane, these orders
now appear on the AccuView display board when the employee recalls the order from the Aloha
Takeout interface. The consumer can quickly verify if the order is correct.

This increases the efficiency of the drive-thru operation without the need for the employee to verbally
confirm the order with the consumer, and eliminate valuable time spent at the audible display board.
There is no configuration required for this enhancement.

To display app orders from ATO on the AccuView display board:

1. The consumer arrives and gives the app order details at the audible AccuView display board in
the drive-thru lane.

2. The employee navigates to the Future Orders tab on the ATO interface, selects the appropriate
order from the list, and presses Order Details. The order appears on the display board for
confirmation.
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For a dual lane drive-thru, the employee can press Send to Display Board, select the lane at
which the car arrived, and click OK. The order appears at the specified display board.

Show on Display Board
Display Boards

Y N

Display Board 1

4 N

Display Board 2

|., — @ | ‘ = / ’

-

Figure 6 Show Display Board Screen

3. When the consumer confirms the order, the employee presses Check In.
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Other products included in the Aloha Solution

The following products are also included in the Aloha Solution:

Aloha Engage Mobile — Release notes are available on hitps: //engage.readme.io/. A password is
required.

Aloha Insight / Aloha Loyalty / Stored Value / Customer Voice — Release notes are available
within the product on the Enterprise website.

Basic Loyalty (Consumer Marketing solution) — Release notes are not available at this time. This
product is still in the SRT phase.

Command Center — Release notes are available within the product. Select the Info icon on the right
and then select Release Notes from the menu that appears.

Configuration Center — Release notes are available within the product. Select the Info icon on the
right and then select Release Notes from the menu that appears.

Digital Ordering — Release notes are available on docs.ncr.com.
NCR Voyix Back Office for Enterprise — Release notes are sent to customers, as needed.
NCR Voyix Mobile Pay — Release notes are available on docs.ncr.com.

Pulse Real-Time — Release notes are available within the app.
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NCR Voyix welcomes your feedback on this document. Your comments can be of great value in

helping us improve our information products. Please contact us using the following email address:
Documentation. HSR@NCRVoyix.com
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